Contents

Introduction ................................................................................................................................................2
  What’s in this manual.................................................................2
  Prerequisites............................................................................2
  Symbols and conventions .........................................................2
  Product support .......................................................................3

Part 1: Overview ............................................................................6

Chapter 1: Terminology ....................................................................7
  Application structure..............................................................7
  Storing modifications ..............................................................8
  Types of modifications .............................................................8

Chapter 2: Starting the Modifier ....................................................9

Part 2: Lessons ............................................................................12

Chapter 3: Selecting a Form to Modify .......................................13
  Lesson: Selecting a form to modify .........................................13

Chapter 4: Modifying a Window ..................................................15
  Lesson: Hiding a field .............................................................15
  Lesson: Modifying a prompt .....................................................17
  Lesson: Setting the tab sequence ............................................19
  Lesson: Setting the window open position ..............................20

Chapter 5: Setting Access to a Modified Form .........................23
  Lesson: Setting access to a modified form ...............................23

Chapter 6: Creating a New Field .................................................27
  Lesson: Creating a new field ....................................................27

Chapter 7: Making Global Modifications ..................................31
  Lesson: Changing push button static text ...............................31
  Lesson: Changing a string resource ........................................32
  Lesson: Expanding the Phone Number field ............................33
  What to do next .......................................................................36

Glossary ....................................................................................37

Index ..........................................................................................39
Introduction

Welcome to the Modifier, the tool you can use to customize the appearance of Microsoft Dynamics® GP. The Modifier offers a variety of features that allow you to modify the look and feel of Microsoft Dynamics GP without affecting the integrity of the accounting system.

What’s in this manual

The Quick Start manual is a hands-on learning tool to help you learn about the Modifier. The manual is divided into the following parts:

- **Part 1, Overview**, introduces the terminology used in the Modifier. It also describes how to start the Modifier.
- **Part 2, Lessons**, shows you how to modify a window, how to access the modification, and make global changes to the interface. By working through the lessons, you will gain a basic understanding of the Modifier.

After you have completed the lessons in this manual, you can continue to the Modifier User’s Guide, which provides detailed information about the product.

Prerequisites

The information in this manual will help you begin learning about the Modifier. It is assumed that Microsoft Dynamics GP is already installed and that you are familiar with it.

Symbols and conventions

To help you use this documentation more effectively, we’ve used the following symbols and conventions within the text to make specific types of information stand out.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Light Bulb" /></td>
<td>The light bulb symbol indicates helpful tips, shortcuts and suggestions.</td>
</tr>
<tr>
<td><img src="image" alt="Warning" /></td>
<td>Warnings indicate situations you should be aware of when completing tasks with the Modifier.</td>
</tr>
<tr>
<td><img src="image" alt="Mouse" /></td>
<td>The mouse symbol indicates information to guide you to the appropriate location in the Modifier.</td>
</tr>
</tbody>
</table>

*Margin notes summarize important information.* | Margin notes call attention to critical information, and direct you to other areas of the documentation where a topic is explained.
INTRODUCTION

Product support

Technical support for the Modifier can be accessed by the following methods:

- **Telephone support** – Technical Support at (888) 477-7877 between 8:00 a.m. and 5:00 p.m. Central Time, Monday through Friday. International users can contact Technical Support at (701) 281-0555.

- **Internet** – Modifier Technical Support is also available online through CustomerSource or PartnerSource, and is accessible from www.microsoft.com/Dynamics/GP.
Part 1: Overview

Use this portion of the manual to become familiar with the terminology used in the Modifier and to learn how to start the product. The information is divided into the following chapters:

- **Chapter 1, “Terminology”** introduces the terminology used in the Modifier.
- **Chapter 2, “Starting the Modifier”** explains how to start the Modifier.

After you become familiar with the terminology, you can continue to **Part 2, Lessons**, to begin making some modifications.
Chapter 1: Terminology

Before you begin using the Modifier, you should become familiar with the terminology used throughout the product. Having a basic understanding of how the Modifier works will help you as you learn about the product.

Application structure

To begin, you must understand the structure of applications created with Microsoft Dexterity,® like Microsoft Dynamics GP. The interface has windows and forms.

Windows

A window is the work area used to enter and display information in an application. Windows in a Dexterity-based application are the actual windows you see when you run the application.

Forms

A form is a collection of windows, menus and other resources that function together for a common purpose. For example, four windows work together to handle customer information. These windows are:

- Customer Maintenance
- Customer Maintenance Options
- Customer Account Maintenance
- Display Credit Limit Warning

They are grouped into a form named RM_Customer_Maintenance.

Forms are typically named based on the type of action the user is performing. Every window in a Dexterity-based application is part of a form. When you use the Modifier to work with window, you must first find and open the form that contains it.

These windows are part of the RM_Customer_Maintenance form.
Storing modifications

All changes and additions you make using the Modifier are stored in the *forms* dictionary for the application. By storing the new and modified resources in a separate dictionary, the integrity of the accounting system can be maintained.

Types of modifications

You can use the Modifier to make three basic types of modifications: modifying the appearance of windows, making global changes to the interface, and adding new fields.

**Modifying windows**

With the Modifier, you can change the appearance of individual windows. This allows you to customize your system to the way you work. For instance, a common window modification is hiding fields that you won’t be using. Another common modification is changing the order in which the focus moves from field to field to reflect the way users enter data.

**Making global interface changes**

The Modifier also allows you to make changes that will be reflected throughout the entire Microsoft Dynamics GP interface. For example, most of the strings that are displayed in the interface can be modified. If you were to modify the string “ZIP Code” and change it to be “Postal Code”, the change would be seen in every place the string “ZIP Code” was used.

**Adding new fields**

You can also use the Modifier to add new fields to windows. This capability is designed primarily for users who also use Visual Basic® for Applications (VBA), Visual Studio® Tools for Microsoft Dynamics GP, or the Continuum API to further customize Microsoft Dynamics GP.
Chapter 2: Starting the Modifier

Before you begin using the Modifier, Microsoft Dynamics GP must already be installed and running properly. The lessons also assume that you have the sample data installed. As you complete the lessons, you will be making changes that will be stored in the forms dictionary for Microsoft Dynamics GP. If a forms dictionary already exists for your installation, we recommend that you make a backup of it before completing the lessons in this manual.

To start the Modifier, perform the following steps.

1. **Launch Microsoft Dynamics GP.**
   Log into the sample company. You must log in as a user that has been granted access to the Modifier.

2. **Start the Modifier.**
   Use one of the following methods to start the Modifier:
   
   - From the main Dynamics GP window:
     In the Microsoft Dynamics GP menu, choose Tools >> Customize >> Modifier.
   
   - From individual task windows:
     In the Tools menu, choose Customize >> Modifier.

   If the Modifier item is dimmed, the Modifier hasn’t been registered or you have not been granted access through security. Refer to the installation instructions included with Microsoft Dynamics GP for information about registering the Modifier. Refer to Chapter 15, “Accessing Modifications,” in the Modifier User’s Guide for more information about setting access to the Modifier.

3. **Select Microsoft Dynamics GP as the product to modify.**
   If you have additional products installed with Microsoft Dynamics GP, a dialog box will be displayed asking you which product you want to modify. Select Microsoft Dynamics GP and click OK.

   ![Select Microsoft Dynamics GP as the product you want to modify.](image)

   If you don’t have any additional products installed, this dialog box won’t be displayed.
After a few moments, the Modifier main window will appear. The Modified Forms window will be displayed.

You’re now ready to complete the lessons in this manual.
Part 2: Lessons

This part of the manual walks you through creating basic modifications with the Modifier. Each chapter contains a detailed step-by-step lesson that you can refer to when making your own modifications.

Some lessons build on previous lessons, so it’s important that you go through the lessons in the order they are presented. The lessons are divided into the following chapters:

- **Chapter 3, “Selecting a Form to Modify,”** describes how to select a form to which you want to make modifications.

- **Chapter 4, “Modifying a Window,”** describes common modifications made to windows.

- **Chapter 5, “Setting Access to a Modified Form,”** explains how to use security to provide access to a form that you modified.

- **Chapter 6, “Creating a New Field,”** explains how to create a new field in the Modifier.

- **Chapter 7, “Making Global Modifications,”** describes common modifications that affect the entire interface.
**Chapter 3: Selecting a Form to Modify**

Before you can make any modifications to a window, you must select the form that the window is part of. Selecting a form causes it to be copied to the forms dictionary. Then you can make modifications to the form.

**Lesson: Selecting a form to modify**

This lesson shows you how to select a form to modify. Before you begin, be sure that you have started the Modifier.

If the Modified Forms window isn’t open, click the Forms button on the toolbar. Click New to open the Select a form to modify window.

For many of the lessons in this manual, you will be modifying the Customer Maintenance window. Select the RM_Customer_Maintenance form and click OK. This will copy the form to the forms dictionary, allowing it to be modified.

*Chapter 3, “Selecting Forms to Modify,”* in the Modifier User’s Guide provides a detailed explanation of how to find specific forms that you want to modify. You will also learn about a shortcut for selecting the form to modify in *Chapter 6* of this manual.

After the selected form has been copied to the forms dictionary, the Form Definition window will automatically open.

In this chapter, you’ve learned how to select a form to modify. The following chapters will show you how to make specific types of modifications, and how to set access to them in the accounting system.
Chapter 4: Modifying a Window

This chapter will show you how to make some common modifications to windows. You will learn how to hide a field, modify a prompt, set the tab sequence and set the opening position of a window.

All of these modifications will be made to the Customer Maintenance window that is part of the RM_Customer_Maintenance form. Before beginning these lessons, be sure that you have completed the lesson in the previous chapter, which adds the RM_Customer_Maintenance form to the forms dictionary.

Lesson: Hiding a field

If the Form Definition window for the RM_Customer_Maintenance form isn’t already open, click the Forms button on the toolbar. Select the RM_Customer_Maintenance form and click Open.

In the Form Definition window, be sure the Windows tab is displayed. Select the RM_Customer_Maintenance window and click Open.

The layout for the RM_Customer_Maintenance window will appear, as shown in the following illustration.
In this lesson, you will hide the Comment 2 field, so it won’t be visible to the user. To do this, select the arrow tool in the Toolbox window. Click on the Comment 2 field to select it.

To make the field invisible, you must set the Visible property for the field to False. You will do this with the Properties window. If the Properties window isn’t open, choose Properties from the Layout menu to display it.

In the Properties window, select the Visual tab. Scroll to the bottom of the list of properties and select Visible.

To set the property, use the settings box at the top of the Properties window. The Visible property is set using a drop-down list. Set the drop-down list to False, indicating the field should not be visible.

After you set the Visible property to false, the Comment 2 field will no longer be visible when the Customer Maintenance window is displayed.

If you mark the Show Invisible Fields item in the Layout menu, any fields whose Visible property is set to false will be displayed in the layout.

Since you’ve hidden the Comment 2 field, you should also remove the prompt associated with the field. To do this, use the Arrow tool and select the prompt in the layout window. Then choose Clear from the Edit menu.
CHAPTER 4  MODIFYING A WINDOW

Save the changes.

Changes you make to windows are saved only when the layout window is closed. At this point, save your work by closing the layout window. A dialog box will appear asking whether you want to save your changes. Click Save.

You can easily reopen the window layout by double-clicking the window name in the Form Definition window.

In this lesson, you learned how to hide a field by setting one of its properties. You also learned how to open and save a window layout. In the next lesson, you will learn how to modify a prompt for a field.

Lesson: Modifying a prompt

This lesson will show you how to modify one of the prompts on the Customer Maintenance window. You will change the prompt for the Comment 1 field to indicate it will store the date the customer’s information was last updated.

If the layout for the Customer Maintenance window isn’t already open, open it by clicking the Forms button on the toolbar. In the Modified Forms window, select the RM_Customer_Maintenance form and click Open. In the Windows tab, select the RM_Customer_Maintenance window and click Open.

To change the text of the prompt for the Comment 1 field, select the Text tool in the Toolbox. Then select the text for the Comment 1 field’s prompt.

Use the Text tool to select the prompt for the Comment 1 field.

Change the prompt text.

Type the following text for the prompt:

<table>
<thead>
<tr>
<th>Prompt</th>
<th>Last Updated</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Updated</td>
<td></td>
</tr>
</tbody>
</table>

Change the prompt’s background color.

When you’ve finished typing the new prompt, select the Arrow tool. Next, you’ll make the prompt easily visible to the user by changing the background color to turquoise and drawing a border around the field. To do this, select the prompt with the Arrow tool. In the Properties window, display the Visual tab and select the BackColor property.
To select a background color, click the lookup button in the Settings box. The Color window will appear. Display the Color tab, select Turquoise and then click OK.

The background color for the prompt will be changed. To have the prompt display properly, change the border style to be two-dimensional:

**Appearance**

**2D Border**

The prompt should look like the following illustration.

Save your changes by closing the window layout, then re-opening it.

In this lesson, you’ve learned how to edit the text for a prompt and how to change prompt characteristics such as the background color. In the next lesson, you will learn how to change the tab sequence for the window.
Lesson: Setting the tab sequence

The tab sequence is the order in which the focus moves through fields in a window when the TAB key is pressed. This lesson will show you how to modify the tab sequence in the Customer Maintenance window.

If the layout for the Customer Maintenance window isn’t already open, open it by clicking the Forms button on the toolbar. In the Modified Forms window, select the RM_Customer_Maintenance form and click Open. In the Windows tab, select the RM_Customer_Maintenance window and click Open.

In the Customer Maintenance window, the focus normally moves from the ZIP Code field to the Country Code field, the Country field, the Declarant ID field, and finally to the Phone 1 field. The following list shows a portion of the original order of the tab sequence.

- City
- State
- ZIP Code
- Country Code
- Country
- Declarant ID
- Phone 1
- Phone 2
- Phone 3
- Fax

For this lesson, let’s assume that we want the Country Code and Country fields to appear after the Fax field in the tab sequence. The following is the desired tab sequence.

- City
- State
- ZIP Code
- Declarant ID
- Phone 1
- Phone 2
- Phone 3
- Fax
- Country Code
- Country

To begin setting the tab sequence, choose Set Tab Sequence from the Layout menu. Customer Number, the first field in the tab sequence, will be highlighted. Press the TAB key several times to move the focus to the Country Code field.

If you accidentally move beyond the Country Code field, press SHIFT+TAB to move the focus to the previous field.
To have the focus move from the ZIP Code field to the Declarant ID field, double-click in the Declarant ID field to move there. Now press the TAB key. The focus will move back to the Country Code field. Double-clicking in the Declarant ID field indicates that you want the Declarant ID field to be next in the tab sequence, rather than the Country Code field.

Double-click in the Phone 1 field to move the focus there. Press the TAB key. The focus will move back to the Country Code field.

Double-click in the Phone 2 field to move the focus there. Press the TAB key. The focus will move back to the Country Code field.

Double-click in the Phone 3 field to move the focus there. Press the TAB key. The focus will move back to the Country Code field.

Finally, double-click in the Fax field to move the focus there. Press the TAB key. The focus will move back to the Country Code field. To complete the process of setting the tab sequence, choose Set Tab Sequence from the Layout menu.

Test the new tab sequence.

To test the tab sequence, you can preview the window. Choose Preview from the Layout menu. A preview of the Customer Maintenance window will be displayed. Press the TAB key several times to see the new tab sequence. When you have finished, close the preview window.

Save the changes.

Save your changes by closing the window layout, then re-opening it.

In this lesson, you learned how to change the tab sequence for a window. In the next lesson, you will learn how to change the original opening position of a window.

**Lesson: Setting the window open position**

Another common modification is to change the initial opening position of a window. This lesson will show you how to set the opening position of a window.

If the layout for the Customer Maintenance window isn’t already open, open it by clicking the Forms button on the toolbar. In the Modified Forms window, select the RM_Customer_Maintenance form and click Open. In the Windows tab, select the RM_Customer_Maintenance window and click Open.

Position the window.

From the Layout menu, choose Position Window. A window will appear that is the size of the Customer Maintenance window.
Move this window to the desired location and click OK. When the user opens the Customer Maintenance window, it will appear in the new position.

Save your changes by closing the window layout. Click OK in the Form Definition window to save any changes that were made to the RM_Customer_Maintenance form.

In this lesson, you learned how to set the opening position for a window. In the next chapter, you will learn how to set access to a modified form so the modifications you made will be accessible by users.
Chapter 5: Setting Access to a Modified Form

This chapter will show you how to set access to a modified form. This is necessary so the modifications you made will be visible for specified users. The Security Setup window is used to grant access to modified forms.

Lesson: Setting access to a modified form

If you are in the Modifier, close any windows that may be open. If prompted, be sure to save any changes. Choose Microsoft Dynamics GP from the File menu to return to the accounting system.

Choose Microsoft Dynamics GP >> Tools >> Setup >> System >> Alternate/Modified Forms and Reports. You may be prompted to enter the system password. The Alternate/Modified Forms and Reports window will appear.

This window is used to define a set of modified and alternate forms. Each user in Microsoft Dynamics GP is assigned to use one of these sets of modified and alternate forms. One set of modified and alternate forms with the ID value DEFAULTUSER is predefined for Microsoft Dynamics GP. In this lesson, you will be specifying that the modified version of the RM_Customer_Maintenance form be used for this set.

The User Security Setup window is used to specify which set of alternate and modified forms and reports a specific Microsoft Dynamics GP user will access.

Set the ID to DEFAULTUSER. This lesson assumes the current user is assigned to view this set of modified and alternate forms and reports.

Make the following selections in the Alternate/Modified Forms and Reports window:

<table>
<thead>
<tr>
<th>Product</th>
<th>Microsoft Dynamics GP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Windows</td>
</tr>
</tbody>
</table>
After you make these selections, the Alternate/Modified Forms and Reports List will contain all of the modified forms for the selected product. For this lesson, the Customer Maintenance window should appear in the list.

Mark the radio button indicating the modified version of the form. This indicates that any user assigned to this set of modified or alternate forms will view the modified version of the Customer Maintenance window.

Click Save to save the changes, and then close the window.

Now you're ready to view the modified version of the Customer Maintenance window in Microsoft Dynamics GP. Choose Cards >> Sales >> Customer. The Customer Maintenance window will appear.
If you completed the previous lessons successfully, the modified version of the Customer Maintenance window will be displayed. Look closely at the window title. The period at the beginning of the window title indicates the modified version of the form is being displayed. You can verify the other modifications you made as well:

- The window has the new default opening position.
- The Comment 2 field is hidden.
- The changes you made to prompts are displayed.
- The tab sequence has been changed.

In this lesson, you learned how to set access to a modified form. You must do this for each modified form you create and for each user that wants to use the modified form. In the next chapter, you will learn how to create and add a new field to a window.
Chapter 6: Creating a New Field

You can use the Modifier to create and add new fields to windows. This capability is designed primarily for users who also use Visual Basic for Applications (VBA), Visual Studio Tools for Microsoft Dynamics GP, or the Continuum API to further customize Microsoft Dynamics GP.

Lesson: Creating a new field

This lesson will show you how to create a new push button on the Customer Maintenance window.

To create a new field for the Customer Maintenance window, you must open the window’s layout in the Modifier. You can use the method that was described in Chapter 4, or you can use the following shortcut.

In Microsoft Dynamics GP, choose Cards >> Sales >> Customer to open the Customer Maintenance window. With this window active, go to the Tools menu, point to Customize and choose Modify Current Window.

The Modifier will start, and the layout for the Customer Maintenance window will be opened automatically. You can use this shortcut any time you need to make changes to a window with the Modifier.

To begin creating a new field, set the drop-down list in the Toolbox to display local fields. Local fields are those that can be used only on windows for the current form.

Create the new field.

Choose Local Fields in this drop-down list.

Click New to create a new local field.

Then click New to create a new local field. The Local Field Definition window will be displayed.
Enter the following information to create the local field:

- **Field Name**: Create Feedback
- **Array Size**: 0
- **Control Type**: Push Button

Next, you will create the static text for the new field. This is the text that will appear on the push button when it is displayed in the window. To do this, click the lookup button next to the Static Values field.

The Button Items window will be displayed. Enter the following information for the Up caption:

- **New Value**: Feedback

The window should look like the following illustration.

Click OK to save the new static item. Then click OK in the Local Field Definition window to save the new local field.
Next, you will add the new field to the window. To do this, click on the Create Feedback field in the list in the Toolbox and drag it to the layout window. When you release the mouse button, the field will be placed in the layout area.

Drag the new field to the area next to the Print button. You can use the arrow keys to precisely position the new field.

Set the following properties for the field, so it more closely resembles the other push buttons on the window.

- **Appearance**
- **BackColor**
- **3D Highlight**
- **System - Toolbar**

Save the changes.

Close the window to save the changes to the window layout. Click OK in the Form Definition window to save the changes you made to the form.

View the new button.

Now you’re ready to see the new field. Choose Microsoft Dynamics GP from the File menu to return to the accounting system. Choose Cards >> Sales >> Customer to display the Customer Maintenance window. You should see the new button in the window.

In this lesson, you learned how to add a new field to a modified window. Refer to the documentation for Visual Basic for Applications, Visual Studio Tools for Microsoft Dynamics GP, or the Continuum API for information about adding functionality to new fields you create.
Chapter 7: Making Global Modifications

You can also use the Modifier to make global modifications that will appear throughout the entire interface. The chapter will show you how to modify static text for a push button, change a string that appears in the interface, and modify the length and format of the Phone Number field.

Lesson: Changing push button static text

In this lesson, the static text for the Save button will be changed to include an access key. Because this change is being made to the data type for the Save button, the change will appear throughout the entire interface.

In the Modifier, click the Data Types button on the toolbar to display the Data Types window. Select the PB_Save data type and click Open.

The PB_Save data type is the resource that specifies the characteristics of the Save button that appears in Microsoft Dynamics GP. One of the characteristics it specifies is the text that appears on the button.

To change the text on the push button, click the Static Values lookup button to display the static text for the Save button data type.

Push buttons can be clicked using access keys (pressing ALT in combination with a letter). When the push button is displayed, an underscore beneath one of the letters in the static text for the push button indicates the button has an access key. To define an access key, place an ampersand (&) in the static text value for the button before the letter that will act as the access key. In this lesson, you will change the static text for the Save button to define an access key.
To change the static text, simply edit the appropriate Caption field in the Button Items window. Insert an ampersand (&) immediately before the v, and click OK.

Click OK in the Data Type Definition window to save the changes to the PB_Save data type.

Now you can view the change you made to the Save button. Choose Microsoft Dynamics GP from the File menu to return to the accounting system. Choose Cards >> Sales >> Customer to display the Customer Maintenance window.

Notice that the v in the Save button is underlined, indicating it has an access key. Any other buttons that are based on the PB_Save data type will also have this access key defined.

**Lesson: Changing a string resource**

A string is a sequence of up to 79 characters that doesn’t contain carriage returns. Strings are used throughout the accounting system for window names, field prompts and static text values. When you change a string resource, the string is changed throughout the interface.

In this lesson, you will change the string “Customer ID” to “Client ID”. By changing the string resource, the change will be reflected throughout the entire interface.

In the Modifier, choose Strings from the Resources menu. After a few moments, the Strings window will appear.

The strings in the dictionary are divided into several cores, which are special divisions in the dictionary. A core exists for each major module category. The Customer ID string is located in the Sales core, so set the Core drop-down list in the Strings window to Sales. Scroll through the list of strings until you locate Customer ID.
Change the string.

Click Open to open the String Definition window.

In the String Definition window, change the text to Client ID, then click OK.

View the change.

Close the Strings window and return to Microsoft Dynamics GP by choosing Microsoft Dynamics GP from the File menu. Choose Cards >> Sales >> Customer to display the Customer Maintenance window. Notice that the first field in the window is Client ID, rather than Customer ID.

Customer ID will have been changed to Client ID throughout the interface.

This change will be appear throughout the entire interface, regardless of whether or not windows have been modified.

Lesson: Expanding the Phone Number field

The data type on which a field is based specifies the storage size, which is the number of characters that can be stored by the field. It also specifies the keyable length, which is the number of characters the user can type into the field. Some fields, such as the Phone Number, have a storage size that is much larger than the keyable length. You can use the Modifier to expand the keyable length for these fields to allow the user to enter more characters into them.

The Phone Number field stores phone numbers up to 10 digits with a 4 character for an extension. This lesson will show you how to expand the keyable length of the Phone Number field and apply a new format that allows the field to store much larger phone numbers.
In the Modifier, click the Data Types button on the toolbar to display the Data Types window. Select the Phone_Number data type in the list and click Open. This is the data type that is used for phone number fields in Microsoft Dynamics GP.

In the definition for the Phone_Number data type, notice that the keyable length is 14, but the storage size is 22. You can expand the keyable length to one character less than the storage size. For the Phone_Number data type, this means the keyable length can be expanded to 21 characters.

Change the keyable length.

To expand the keyable length for the phone number, make the following entry:

Keyable Length 21

The format used for a data type also controls how many characters can be entered in a field. Think of a format as a data “mask” that changes the appearance of information in a field, but doesn’t actually change the information.

The default format used for the Phone Number field allows a phone number to be entered in the standard U.S. format:

(XXX) XXX-XXXX Ext. XXXX

The format must be changed to utilize the additional characters made available by expanding the keyable length. To change the format, click the Format lookup button, next to the Format field in the Data Type Definition window. The Format Lookup window will be displayed. Select the Phone_Number format and click Open.
The Format Definition window will be displayed, as shown in the following illustration.

Notice the entry in the Format Strings field. This string indicates how characters can be entered in the fields that use this format. The current format string allows phone numbers to entered in the standard U.S. format. You will change the format string to allow more characters to be entered.

Remove the existing format string.

To remove the existing format string, select it in the Format Strings list and then click Remove.

Enter the new format string.

Next, enter the following string the Format String field:

Format String: 

**XXXXXXXXXXXXXXX Ext. XXXX**

Click Insert to add the new format string to the Format Strings list. Each X in the string indicates a position where the user can type a character.
Set the fill character for the format.

When the Phone Number field is displayed, each X will be replaced by a “fill” character. Currently, this fill character is a zero (0). For the best appearance, change the Fill drop-down list to Space. Then, each X will be replaced by a space when the Phone Number field is displayed.

![Set the Fill character to Space.](Fill: Space)

Save the changes.

When you have finished, click OK to close the Format Definition window. Click OK to close the Data Type Definition window and save the changes made to the data type.

View the changes.

Return to the accounting system by choosing Microsoft Dynamics GP from the File menu. Choose Cards >> Sales >> Customer to display the Customer Maintenance window. Notice that the Phone Number fields can store several additional characters, allowing long phone numbers to be stored.

Phone 1 44-151 333 3040, Ext. 445

Each Phone Number field can store several additional characters.

What to do next

Now that you are familiar with the basics of the Modifier, you can begin making your own modifications. For more information about how to use the Modifier, refer to the Modifier User’s Guide. You can also refer to the Modifier online help for descriptions of each window.
**Glossary**

**Accelerator key**
A key or set of keys on the keyboard that can be used as a “shortcut” to select a menu or menu option rather than using the mouse.

**Access key**
An underlined character in a menu name or item that allows users to select the item by typing the underlined character or by holding down the ALT key and typing the character.

**Control type**
The main characteristic of a data type, controlling the type of information that can be stored in fields that use that data type, and some aspects of how the information will be displayed. Commonly-used control types are push button, integer, check box, date and currency.

**Data type**
A resource that defines the characteristics for a field, such as its keyable length, control type (push button, check box, string and so on) and format. A single data type can be applied to several fields, but a field can have only one data type applied to it.

**Definition window**
A window that allows you to create or edit a resource and specify its functional characteristics.

**Dictionary**
A group of resources that, when interpreted by the runtime engine, present a complete functioning application.

**Field**
A field contains a single piece of information used by an application. A field can be displayed on a window or stored in a table. The kind of information the field displays or stores depends on the data type associated with it. See also Global field and Local field.

**Focus**
The indicator that shows the object being controlled in the current window.

**Form**
A collection of windows, menus and other resources that function together for a common purpose.

**Format**
The extra characters, spacing and attributes that can be applied to a data type when data is entered or displayed.

**Format string**
A data “mask” used for string and composite formats. The format string allows extra characters to appear in a field without affecting the way data in the field is stored.

**Forms dictionary**
The dictionary that stores user-modified resources. This dictionary is created when the Modifier is accessed for the first time. Only copies of a dictionary’s resources are stored in the forms dictionary.

**Global field**
A field that can be displayed in windows and also stored in tables. The characteristics of global fields can be viewed with the Field Definition window. See also Local field.

**Keyable length**
The number of characters that can be typed in a field.

**Keyboard equivalent**
A key combination that will activate a menu item as an alternative to selecting it with the mouse.

**Layout window**
A window in the Modifier that allows you to design the layout of a window or scrolling window.

**Local field**
A field that’s available only within the form in which it’s created. Local fields are used as window fields. The Modifier can create local fields. See also Global field.

**Modified form**
The copy you make of the original form. Modified forms are added to the Forms dictionary. You can select the modified form and customize the windows belonging to it. See also Original form.

**Original form**
An unmodified form that is stored in its original dictionary. You must make a copy of an original form before you can make modifications to it. See also Modified form.

**Prompt**
Text in a window that shows the user the information that is displayed or can be entered in the corresponding field or fields.

**Property**
An attribute that can be assigned to fields, windows or graphical objects displayed in a window layout. For example, a window with the Resizeable property set to False cannot be resized by the user.

**Push button**
A control type used to define data types for buttons users can click to accomplish tasks. Static text or pictures can be used to indicate the button’s function.

**Runtime engine**
An application that’s used to interpret a dictionary. When a user starts an application, the runtime engine uses the resources in the dictionary to present a functioning application.

**Series**
A predefined category to which form and table resources are assigned. Series allow categorization of resources.

**Static text value**
Text that’s displayed as part of a data type, such as the name of a push button or the items in a list box.

**Storage size**
The size, in bytes, used store the information in a field. The storage size is specified in the field’s data type. It can’t be changed by the Modifier.

**Storage type**
One of the standard forms used to store the data in a field. The common storage types are: boolean, integer, long, currency, string, text, date, and time. The control type determines which storage type is used to store the data in the field.

**String resources**
Sequences of up to 79 characters used throughout a dictionary for window names, field prompts and static text values.

**Tab sequence**
The order in which the focus moves from one field to the next field when the user presses the TAB key.

**Toolbox**
A window that opens in conjunction with the Window Layout and Scrolling Window Layout windows. It contains tools used to place and arrange items in the layout area.

**Visual Basic for Applications (VBA)**
A development system created by Microsoft that can be embedded into applications. VBA is embedded into the Modifier, where it provides additional customization capabilities.

**Visual Studio Tools for Microsoft Dynamics GP**
A development toolset based on the Microsoft .NET framework that can be used to create integrations for Microsoft Dynamics GP. Microsoft Visual Studio is the development tool used to create these integrations.

**Window**
The work area used to enter and display information in an application.

**Window field**
A global or local field that has been added to a window layout.

**Window layout**
The layout window that represents the window you’re modifying.
Index

A
accelerator key, defined 37
access keys
defined 37
described 31
Alternate/Modified Forms and Reports window 23

B
Button Items window 28, 32

C
colors, selecting for field background 18
control types, defined 37
correlations, in documentation 2
Creating a New Field, chapter 27-29

D
Data Type Definition window 31, 34
data types, defined 37
Data Types window 31, 34
definition windows, defined 37
dictionaries, defined 37
documentation, symbols and conventions 2

F
fields
adding to window layout 29
creating 27
defined 37
expanding 33
hiding 15
focus, defined 37
Form Definition window 13, 15
Format Definition window 35
format strings, defined 37
formats
defined 37
described 34
format string 35
forms
accessing 23
defined 37
described 7
elements 7
selecting a form to modify 13
forms dictionary, defined 37

G
global fields, defined 37
global modifications 31

K
keyable length
defined 37
described 33
keyboard equivalent, defined 37

L
Layout window 15
layout windows, defined 37
lessons
Changing a string resource 32
Changing push button static text 31
Creating a new field 27
Expanding the Phone Number field 33
Hiding a field 15
Modifying a prompt 17
part 12-36
Selecting a form to modify 13
Setting access to a modified form 23
Setting the tab sequence 19
Setting the window open position 20
light bulb symbol 2
Local Field Definition window 28
local fields
defined 37
described 27

M
Making Global Modifications, chapter 31-36
margin notes 2
modifications
accessing 23
storing 8
types of 8
modified forms, defined 37
Modifier
described 2
prerequisites 2
starting 9
storing modifications 8
terminology 7
types of modifications 8
Modifying a Window, chapter 15-21
mouse symbol 2

O
original forms, defined 37
Overview, part 6-10

P
Position Window window 20
previewing windows 20
product support, for the Modifier 3
prompts, defined 37
properties
defined 37
setting 16
Properties window 16, 18
push buttons
access keys 31
changing static text 31
defined 37

R
runtime engine, defined 37

S
saving changes for windows 17
Select a form to modify window 13
Selecting a Form to Modify, chapter 13
series, defined 37
Setting Access to a Modified Form, chapter 23-25
Starting the Modifier, chapter 9-10
static text values, defined 37
storage size
defined 37
described 33
storage types, defined 37
String Definition window 33
strings
changing 32
defined 37
described 32
Strings window 33
support, available for the Modifier 3
symbols in documentation 2

T
tab sequence
defined 37
described 19
testing 20
technical support, for the Modifier 3
terminology
chapter 7-8
for Modifier 7
Toolbox, defined 37
Toolbox window 27
types of modifications 8

V
VBA, defined 37
Visual Studio Tools for Microsoft Dynamics GP, defined 37

W
warning symbol 2
window fields, defined 37
window layout, defined 37
windows
default open position 20
defined 37
described 7
modifying 15
previewing 20
saving changes 17
windows in Microsoft Dynamics GP,
Alternate/Modified Forms and Reports 23
windows in Modifier
Button Items 28, 32
Data Type Definition 31, 34
Data Types 31, 34
Form Definition 13, 15
Format Definition 35
Layout window 15
INDEX

windows in Modifier (continued)
Local Field Definition 28
Position Window 20
Properties 16, 18
Select a form to modify 13
String Definition 33
Strings 33
Toolbox 27